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Introduction

Overview

InfoRad is the premier provider of instant information solutions since 1984. InfoRad presents AlphaPage® First Responder, a text messaging solution that allows users to send text messages to any user of wireless receivers (alpha-numeric pagers, wireless PDA’s, and PCS phones with short messaging capability).

 XE "Other Products" Other Products

Free 30 day Trial versions are available for download for most products at www.inforad.com/demos
Contact InfoRad Sales for more information or to purchase:

Phone: 800-228-8998

E-mail: sales@rnforad.com
Products may be also purchased on-line at www.inforad.com/products
InfoRad Wireless Office
InfoRad’s most popular Messaging Software. Internet and dial-up (TAP) messaging., basic (One-Time) Message Scheduling, Pre-defined messages, Groups, message logging.

InfoRad eText™
Low cost alternative of Wireless Office for basic messaging capability. InfoRad eText™ supports Internet messaging only. 

InfoRad Wireless Pro 
Wireless Office features with expanded Groups (500 Receivers per Group), expanded Pre-defined Messages (500), expanded Scheduled Messages (500), and NEW Advanced Scheduler (recurring scheduled messages - daily, weekly, monthly), and  NEW Spell Checker .

AlphaPage® 

First Responder
Includes all Wireless Pro features including NEW Advanced Scheduler and NEW Spell Checker plus NEW Route on Failure – automatic rollover to secondary receiver address on primary error, NEW Message Templates (pre-programmed ‘fill in the blank’ type messages), and Direct Serial Connection messaging option for use with on-site paging systems or leased-line connections.

Watch-IT ASCII™
Turns your wireless receiver into a monitoring device for critical applications that produce ASCII text files. (Integrates with CAD Systems, and dispatch/service software applications like Bottom Line Software and  Wintac™.

Watch-IT ASCII SV™
Watch-IT ASCII that runs as a Service on Windows™ NT4.0, 2000, XP, 2003 Server. 

Watch-IT ASCII-75™
Low cost, reduced capabilty Watch-IT ASCII for small shops such as  HVAC, plumbing, electrical, mechanical, couriers, and taxi services. See Watch-IT ASCII for full-featured product.

Watch-IT Serial™
Allows automated dispatch of wireless messages from any computer system platform by monitoring a serial port information stream.

Monitor-IT™
Monitors the integrity of a wireless messaging system, reporting system failure via a secondary wireless system or e-mail.

Serve-IT™
Customizable application that allows for integrating wireless messaging into an existing customer service environment.

InfoRad Enterprise™
A Client/Server solution for sharing the InfoRad Wireless messaging system over a LAN or WAN. Wireless Pro and AlphaPage® First Responder features including Internet and dial-up (TAP) messaging, NEW Advanced Scheduler, NEW Spell Checker, NEW Message Templates, NEW Route on Failure features, and Direct Serial Connection messaging option for use with on-site paging systems or leased-line connections.

InfoRad Enterprise SV™
InfoRad Enterprise with the Messaging Server runs as a Service on Windows™ NT4.0, 2000, XP and 2003 Server.

InfoRad Enterprise iNet™
Low cost, reduced capabilty Enterprise. Available in 2 and 3 Concurrent Client license only. Enterprise iNet supports Internet messaging only. Includes NEW Spell Checker and NEW Advanced Scheduler features. For full-featured product see InfoRad Enterprise and InfoRad Enterprise SV.

Support

Technical Support is only available to registered users of the software as detailed in the licensing agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support XE "Technical Support" \r "D2HBTechnical_Su6"  included. AlphaCare Subscription optionsxe "Support"

xe "Technical Support" are available that extend the support period, as well as offer priority telephone support and Upgrade Protection. Out-of-warrantyxe "Warranty" support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at www.inforad.com/techsupport
Phone:
(216) 531-1369

E-mail:
techsupport@inforad.com

Internet:
www.inforad.com

 XE "System Requirements" 

 XE "Installation: Requirements" AlphaPage First Responder System Requirements

[image: image2.png]



AlphaPage® First Responder

The AlphaPage® First Responder wireless messaging software was written to operate on computers with at least 4 megabytes of hard disk space available, running Windows 2000 or greater. Dial-up (TAP) messaging requires computers equipped with a Hayes-compatible modem.
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AlphaPage First Responder Features

· AlphaPage First Responder is easy to install and provides fast, intuitive entry and dispatch of your text messages. Expanded Group Members, Scheduled and Predefined Messages.

· Message by Name, Group or Wireless Receiver phone or ID number easily through any Messaging Service that accepts remote alphanumeric/text messaging.

· Take advantage of sending messages while performing other tasks on your computer.

· Drop down selections and alphabetical search functions assist you with setup, directory features, and sending your messages.

· Message from home, office, or on the road by using Windows dialing options. You can even use your phone credit card.

· Message entry includes use of cut and paste functions, recall of previous messages, pre-programmed messages, and an optional Auto-Split feature for long messages - up to 1024 characters.

· Schedule messages to be sent at a specific date and time. Use messages as reminders for meetings, recurring events, and more. 

· Directories can be listed by wireless receiver phone or ID #, Name, Group, and Wireless Messaging Service. Your listing also includes message and packet counts.

· Message logging XE "Message Logging" 

 XE "Logging"  with time/date stamp. 

· Communications options offer you maximum setup flexibility and full compatibility with practically any modem.

· Experienced live technical support available.

· Long block/message chaining capable.

· PCS phone short messaging services (SMS).

· Send messages over the Internet (via modem or network connection) directly to your Messaging Services Internet Server via Internet messaging protocols WCTP & SNPP.  Messaging via Internet E-mail (SMTP) also supported.

· Receive message responses to your e-mail address, or your wireless receivers e-mail address, from 2-way devices with WCTP and SMTP services. 

· Send messages to on-site/customer-owned paging system or via leased-line connection to Messaging Service with Direct Serial Connection Option. 

· HTTP Proxy Authentication support for WCTP Services.

· SMTP Authentication support for E-mail messaging.

· WCTP Authentication support.

· NEW Advanced Scheduler – schedule recurring daily, weekly, monthly messages/reminders. 

· NEW Spell Checker – check and correct messages before sending. 

· NEW Message Templates – preformatted, fill-in-the-blank messages.

· NEW Route on Failure – alternate delivery destination / alternate receiver delivery on primary failure.

· Extended AlphaCare™ Support Services available: Priority Technical Support, FREE updates. Keep your product current with changing Operating System and Wireless specifications.

What You Need to Get Started

How does a text message get from your computer to your wireless receiver? Unlike sending a numeric message, sending a text message is a three-step process:

1. Messaging via the following options:

a.  Dial-up TAP service: AlphaPage First Responder uses your computer's modem to dial into the Wireless Messaging Service's modem Phone Number. This number is different from your Wireless Receiver number. If you don't have a Service Phone Number, contact your wireless messaging or short messaging service.

b.  Internet service WCTP & SNPP: AlphaPage First Responder uses your Intenet connection (Dial-up ISP, broadband, or network) and connects to the service’s Internet Server for WCTP & SNPP services. If you don’t have the Internet address for the WCTP or SNPP service, contact your wireless messaging or short messaging service.

c. Internet E-mail (SMTP): AlphaPage First Responder uses your Internet connection (Dial-up ISP, broadband, or network) to connect to your ISP or network e-mail server. If you do not have your e-mail server address, contact your ISP or network administrator. 

d. Direct Connection: 

I. AlphaPage First Responder uses your computer’s serial port and a leased-line modem to connect to your Wireless Messaging Service or on-site paging system.

II. AlphaPage First Responder uses your computer’s serial port and a serial cable connection to connect to your on-site paging system.

2. After a connection is made to your wireless messaging service, AlphaPage First Responder uploads the wireless receiver ID number and the message you wish to send.

3. After AlphaPage First Responder disconnects, your wireless messaging service broadcasts the message through their radio tower and out to your wireless receiver.

For every wireless receiver you wish to set up, you will need the following information:

1. The Wireless Receiver Number. If your wireless messaging service uses PIN Numbers or Cap Codes, you will need the PIN Number or Cap Code for your wireless receiver. Otherwise, you will just need the Wireless Receiver Phone Number. If using Email (SMTP) you will need the e-mail address for your wireless receiver. 

2. The Service Provider Phone Number or Service Provider SNPP or WCTP Internet Address and Port or E-mail Server Address. The Service Provider phone number is the dialup number for your wireless messaging service, also sometimes called a Access Number, Terminal Number, Modem Number, Alpha Port phone number, or Short Messaging Service phone number. If you dial this number from a telephone, you should hear a screeching noise, like a fax machine. If connecting through the Internet, the SNPP or WCTP address and port are used to transmit your message to the service provider; the E-mail Server address is used to relay your message through the Internet mail system.
If you are unsure of any of the required information, contact your wireless messaging or short messaging service.

 XE "Installation: Install Procedure" Installation

Installing AlphaPage First Responder on your Hard Drive

1. Make a back-up copy of your AlphaPage First Responder disk or download file.

2. To install AlphaPage First Responder on your computer hard drive, run the Setup file or download file.

3. The AlphaPage First Responder Installation wizard license agreement XE "License Agreement"  screen will appear. Click on the “I agree” button to continue the installation of AlphaPage First Responder.

4. The AlphaPage First Responder Installation wizard will appear. Click on the Next button or press Return to continue the installation of AlphaPage First Responder.

5. You are then prompted for a destination directory for the installation. If you wish to change the directory where the AlphaPage First Responder application will be installed, click on the browse button and select a new directory. Otherwise, click on the Next button to continue the installation process.

Note: If you are re-installing or upgrading AlphaPage First Responder, the installer will also ask if you wish to use the existing messaging database files and program setup files, or replace them.

6. Next select Program Access for Current User or ALL Users. Selecting Current User will store Program Settings in the Windows Current User Registry. Selecting ALL Users will store the Program Settings in the Windows Local Machine Registry (All Users). Selecting ALL Users may require Administrative privileges.

7. You are then asked if you wish to create a shortcut on the desktop for the AlphaPage First Responder application. Click on the Next button once you have made a selection.

8. Ready to Install! Click next and Setup will then install the program files.
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Once the program files are installed, the program will prompt you for program setup information. Click on the Next button to begin the program setup.

9. Select whether you will be using a Modem (dial-up Messaging Service or ISP) or network/DSL/Cable Internet connection to send messages. If you will be using both, select Modem to start the Modem Setup Wizard.

10. If you selected Modem above, the Modem Setup Wizard will begin. Click Next to go to Communications Setup. (See “Communications Setup” on page 13 for full details). Please note if you are using a dial-up Internet connection, after Setup completes you will need to select the Internet Connection to use (Setup Menu / Internet Settings).

11. Next, if you purchased the retail version of AlphaPage First Responder, the Wireless Messaging Service wizard is opened. Enter the default wireless messaging service information as prompted. (See “Building Your Wireless Messaging Services Directory” on page 28 for details).

12. After you have entered a wireless messaging service, the Add Wireless Receiver wizard is started. Enter at least one receiver number, and click Finish when finished. (See “Building Your Wireless Receiver Directory” on page 38 for details).

13. Your AlphaPage First Responder installation is now complete. To run AlphaPage First Responder, click on the AlphaPage First Responder icon located in the AlphaPage program manager group.

14. Click on the Register Now or Register Later buttons. If you choose to Register Later the Registration dialog is accessible from the Setup menu after installation.
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If you select the Register Now button, the program will automatically open your internet browser to the InfoRad Product Registration website.

Registration is necessary for technical support XE "Technical Support" \r "D2HBTechnical_Su11"  and notification of future upgrades
 XE "Installation: Problems" 

 XE "Problems: Installation" 

 XE "Installation: Install Procedure" Installation Problems?

Should you require additional assistance with AlphaPage First Responder, please briefly document your problem and questions, serial number and version number. 

Technical Support Options

Technical Support is only available to registered users of the software as detailed in the licensing agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support XE "Technical Support" \r "D2HBTechnical_Su6"  included. AlphaCare Subscription optionsxe "Support"

xe "Technical Support" are available that extend the support period, as well as offer priority telephone support and Upgrade Protection. Out-of-warrantyxe "Warranty" support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at www.inforad.com/techsupport
Phone:
(216) 531-1369

E-mail:
techsupport@inforad.com

Internet:
www.inforad.com

 XE "Setup: Options" \r "D2HBSetup_Option13" 

 XE "Installation: Options" \r "D2HBSetup_Option13" Setup Options

 XE "Setup: Overview" Setup Overview
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Your AlphaPage First Responder software is configured for compatibility with your computer system during installation. AlphaPage First Responder provides you with additional communications options should your system or personal needs require them. Access to these features is achieved by selecting the option from the Setup menu.

There are four main setup options:

· Communications Setup
· Internet Setup
· Preference Options
· Change Graphics Option
Communications Setup

The Communications Setup defines the settings and options used by AlphaPage First Responder when connecting to Messaging Services that are programmed to connect via ‘modem dialup (TAP)’.

AlphaPage First Responder uses the Windows communications settings and dialing properties, XE "Communications Setup" 

 XE "Setup: Communications"  allowing you to easily use your current Windows modem settings when setting up AlphaPage First Responder. In addition, there are several modem configuration options that you can use to further define how AlphaPage First Responder uses your modem.

To setup AlphaPage First Responder’s communication settings, select Communications from the Setup menu. The Communications Setup  dialog is displayed.
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Modem Dialup Connection Settings

The Modem dialog lists all available modems on the current system and modem configuration settings. 

When you are finished with the modem selection and configuration, click on OK to finish the communications setup process.

Use this modem to send messages: Click on the drop-down box to select the modem you wish to use with AlphaPage First Responder.

Modem configuration: The standard Windows modem settings should work with AlphaPage First Responder. However, if you should need to modify the modem settings for use with AlphaPage First Responder, additional modem configuration XE "Modem: Initialization String" \r "D2HBModem_Config17"  settings are available from within the Modem  dialog.

From this dialog you can change the following options:

· Modem Configuration

· Communications Log
· Flow Control
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Note: AlphaPage First Responder uses your Windows settings to determine what modems are available and how to dial phone numbers. To modify the dialing properties in Windows click on the Dialing tab in the Communications Setup screen.



 XE "Flow Control" \r "D2HBRedial17" Modem Configuration

If your modem requires a unique initialization string, select “Override the system’s modem configuration, use this initialization string instead:” and enter your modem’s initialization string:

1. If you are unsure of what initialization string you should use, try using the “Create” button. AlphaPage First Responder will automatically build a custom modem initialization string for your modem.

2. If the custom initialization string built by “Create” does not work, enter a custom modem initialization string manually. See

“Using High Speed and Fax Modems” on page 16 for more information on creating a custom initialization string.

Note: If you change the modem selection in Communications Setup, you must first Click on the Apply button to activate the Create function to allow automatic setup of an initialization string for the newly selected modem.

Flow Control

The flow control settings allows you to enable/disable modem flow control, and select between software (XON/XOFF) flow control and hardware (RTS/CTS) flow control (default setting). Normally there is no need to change this setting.

Communications Log

The “Keep a log of communications activity for diagnostic purposes” checkbox enables communications logging of all modem connections to a files named CM*.txt, which is saved in the program installation directory.

The log filename is CM, followed by the day of the month, followed by the time of day - for example, a message or group of messages sent on the 6th day of the month at 9:15am would have a log file with the name CM060915.txt.; at 9:15pm the filename would be CM062115.txt
Using High Speed and Fax Modems

If you need to use a custom modem initialization string and are using a Fax modem, a high-speed modem (above 2400 baud), or a modem with error correction or data compression features, several of your modem’s advanced features will typically need to be disabled to achieve successful communications with a wireless messaging service’s answering modem. 

If you are not familiar with the proper commands, syntax, or command order for your particular modem, please reference your modem user manual or contact your modem manufacturer’s technical support XE "Technical Support"  staff. Also note the following settings for a typical initialization string:

· Select Bell mode (For U.S.)

· Select CCITT mode (For European and other countries)

· Error correction = OFF

· Data compression = OFF

· Auto baud adjust = OFF or ON

· Return verbal result codes = ON (typically Q0V1)

· Extended result codes (typically X4 to return BUSY, NO DIAL TONE and CONNECT message with speeds)

· Flow control = OFF

· Operation mode = Normal mode

· Modem reset on DTR transition = ON

· Trellis Encoding = OFF

· Communications mode = asynchronous

Note: Try adding an &F at the beginning of the init string to reset modem before issuing other commands. Try setting the operation mode to direct mode if normal mode fails. Some modems use the “+MS” command to set the speed of the modem. A typical setting will look like the following:

+MS=B103        for a 300 baud rate connection

+MS=B212        for a 1200 baud rate connection

For more information on modem configuration, please see http://www.inforad.com/modemtech.html
Internet Setup

Access the Internet Setup by selecting Internet Settings from the Setup Menu.

Internet Setup section allows you to configure:

· Internet Connection Settings
· Telnet Proxy Setup Options
· ReplyTO Address
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 XE "Internet Connection" \r "D2HBInternet_Con15" 

 XE "Connection: Internet" \r "D2HBInternet_Con15" Internet Connection Settings

These settings are used for internet-based XE "SNPP"  messaging services (WCTP, SNPP, SMTP(E-mail)). The following are the Internet connection options:

Connect to the Internet through: You can configure the software to connect to the Internet through your local network, or you can select a dial-up Internet connection. If you select a dial-up Internet connection, you will need to enter the login account name, account password, and optional domain name.

Reconnection options: These settings define the number of redial attempts to connect to Internet if a connection or logon problem occurs (such as a busy signal).

HTTP Proxy Server Authentication: WCTP Messaging Services utilize the HTTP Internet protocol in the same way as your Internet Browser. If your network contains a Proxy Server that requires Authentication to access the Internet, check 'Proxy server requires authentication' and enter your Username and Password required for Internet Access

Keep a log of internet activity for diagnostic purposes: This option enables logging of all internet connections. This is useful to confirm that the computer is successfully connecting to the Internet to transmit messages. When this option is enabled, a file named “inetlog.txt” is saved in the program installation directory. This file contains a log of all internet activity generated by the program, including connection attempts and sent messages.

Telnet Proxy Setup Options

When sending messages via SNPP to a Messaging Service through a network Internet connection that utilizes a proxy server or firewall for network security, it may be necessary to setup AlphaPage First Responder to use a telnet proxy. This may be required since SNPP is not a common port that is open on most Proxy servers or Firewalls. Check with your network administrator to determine if you must use a Telnet Proxy and for proper settings. 

Select the “Use a telnet proxy for SNPP services” checkbox to enable the use of a telnet proxy in the Telnet Proxy tab of Internet Setup.
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Use a telnet proxy for SNPP serivces: XE "Telnet Proxy" \r "D2HBTelnet_Proxy15" 

 XE "Proxy" \r "D2HBTelnet_Proxy15"  If you are using a proxy or firewall with your internet connection, you can select this checkbox to enable proxy use and to specify the proxy settings, including the proxy address and port number. Note that telnet proxy is used only for SNPP Services. (WCTP and SMTP Services will not use a telnet proxy. WCTP connects via an HTTP Proxy if the network requires; SMTP connects via an SMTP server located on your network or at your ISP.)

Telnet Proxy Address and Port: This is the address and port number of the proxy server being used.

Telnet proxy responses: The “Telnet prompt” options specifies the prompt text that the proxy server displays to indicate that it is ready for input. Note that if your Telnet prompt contains a space after the prompt (and before the cursor), you must enter the space as part of your "Telnet prompt" text entry. (To determine your telnet prompt, open a command window and establish a telnet connection to your telnet proxy server. The command prompt that is returned is your "Telnet prompt".)

Telnet proxy commands: The “Connect command” is the command the proxy server will use to connect to the messaging service Internet server. Note: to send the proxy address, enter “ADDRESS”. To send the proxy port, enter “PORT”.

Example: If you enter “CONNECT ADDRESS PORT” in the Connect command field, and your Messaging Service SNPP Internet server address is “snpp.alphatech.com”, and the port is “444”, AlphaPage First Responder will send the command “CONNECT snpp.alphatech.com 444” when connecting to the messaging service Internet server through the Telnet Proxy.

Normally, the proxy connect command is “ADDRESS PORT” or “CONNECT ADDRESS PORT”. Check with your network administrator for the proper commands for your proxy server.

Flow of a Telnet proxy connection: When sending a message utilizing a Telnet Proxy Server, AlphaPage First Responder first establishes a telnet connection to the proxy as defined in the Telnet Proxy Address and Port. When AlphaPage First Responder detects the Telnet prompt (as defined in the Telnet Proxy Setup), it then sends the Connect command (as defined in the Telnet Proxy Setup) using the ADDRESS and PORT as defined in the Messaging Service. The Telnet Proxy then establishes a connection to the Messaging service.  AlphaPage First Responder then sends the message to the Messaging Service via the connection established by the Telnet Proxy.

ReplyTO Address

AlphaPage First Responder supports sending messages to wireless receivers via Internet E-mail using the standard Internet E-mail protocol SMTP. 

To send messages via e-mail please reference the Messaging Service setup.

The ReplyTO Address tab in Internet Setup allows you to define the Reply Address for messages sent via E-mail (SMTP) and WCTP.  Enter your Internet E-mail address in the field. 

If no entry is made in the address field, then message responses and failed to send notices will not be returned.
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NOTE: Some WCTP Messaging Services require the use of a senderID. This field will be used as the senderID (in addition to being used as the reply address) when connecting to WCTP services.

Preference Options

AlphaPage First Responder offers you several wireless receiver preference options XE "Preference Options" 

 XE "Setup: Preferences"  for handling long message input, entering a message “signature,” and more. To set or select your Preference Options, select Preferences under the Setup menu. The General Preferences XE "General Preferences"  dialog will appear.
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General Options

Split long messages into multiple pages: Selecting this option allows you to send messages up to 1024 characters long. Your message is automatically split into shorter messages based on the message length capability defined when you set up your wireless messaging service’s information (see “Building Your Wireless Messaging Services Directory” on page 28).

Require confirmation for deleting and clearing items: This option allows you to select whether AlphaPage First Responder will ask for confirmation upon deleting or clearing items from the Receivers, Groups and Messing Service Directory.

Send button sends all queued messages: This option allows you to select whether AlphaPage First Responder will send all messages in the queue when sending a newly entered message. When not selected the behavior is to send only the newly entered message and queued messages must be sent from the Queue Menu, Send Queue.

Remove duplicate messages: This option allows you to select whether AlphaPage First Responder will remove duplicate messages when sending to multiple Groups. If a Receiver belongs to multiple Groups, the message will be sent only one time if this option is selected. When not selected the behavior is to send the Receiver for each Group it is associated.

Failed Message Retries Options

This option allows you to select the number of attempts that AlphaPage First Responder will make when an error is encountered during sending of a message. For Dial-up TAP messages the program will also attempt redials upon the following conditions: receiving a telephone company busy signal while dialing the messaging service; if the modem is in use by another application; or if the phone line is in use (no dial tone).

There are several retry options available:

Retry when manually typed-in messages fail: This option allows you to select whether AlphaPage First Responder will automatically retry when sending a message that you entered and sent manually.

Retry when scheduled messages fail: This option allows you to select whether AlphaPage First Responder will automatically retry when sending scheduled messages.

Retry attempts: Enter the number of times you wish the program to attempt to send a message that is receiving an error.

Seconds between attempts: Enter the number of seconds you wish the program to wait before retrying.

Bring retry window to foreground: If the program has to attempt to retry, selecting this option will bring the retry window to the foreground (in front of any other open windows).

Password option

Password protect edit controls: Access for editing any of the AlphaPage First Responder setup or directory entries is restricted by selecting this option. Once disabled, access is allowed only by your password. The AlphaPage First Responder default password is “priv”.

Change Password: The password XE "Password"  governs the “Edit Controls XE "Edit Controls" ” option. The default password is “priv”. To change the password, click on the Change Password button, enter your new password, and click on OK. Make sure to document the new password.

Message Signature option

Message Signature: The message signature text allows you to define a short “signature” string of characters that will be attached to each message you send. For example, “John Smith, ARB Inc.” Type in the signature you wish to use in the Signature Text field, and select whether you want the signature inserted before or after each message. When you enter a text message, you will have the opportunity to turn the signature on or off.

Spell Check Option

Spell Check performs a spelling check of an entered message before sending and allows for correction. 

Options: You can use the Options Dialog to specify various spelling-checker options. These options affect the way the spelling-checker operates. Click on the Help button for information on available spelling-checker options. 

Dictionaries: The Dictionaries Dialog allows you to open and close user dictionaries, and to edit the contents of an open user dictionary. The contents of dictionaries are saved in disk files. Click on the Help button for more information on Spell Check Dictionaries.

Scheduled Messages option

Send past due messages: This option allows you to send past due scheduled messages within a user selected time frame. Turning off this option (un-checking the option) will cause all past due scheduled messages to not be sent. If the message is a One-Time scheduled message, the message will be deleted if the scheduled send time is outside the selected time frame for sending past due scheduled messages. If the program has Advanced Scheduled messaging feature (Daily, Weekly, Monthly recurring scheduled messages), the next occurance will always automatically be scheduled after determining to send a past due message.  

If overdue less than: Select the time limit for sending past due scheduled messages from 1-Hour to 1-Month.

Change Graphics Option

If you wish, you can change the background graphic and the text color used by the software. To modify the graphics, select the “Change Graphics…” option from the Setup menu.
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To select a picture to use as the backdrop, enter the directory path and filename of the graphic, or click on the Browse button and then select the graphic file you wish to use.

Next, select a backdrop style: None, Stretch to fit, Centered, or Tiled.

To change the color of the text used in the main screen, click on the Pick Text Color button, and then select the color you wish to use.

When you click on the Ok button, your graphic preferences will be applied to the main screen.

.

 XE "Messaging Directories" 

 XE "Setup: Messaging Directories" Building Your Wireless Messaging Directories

Messaging Directories Overview

AlphaPage First Responder lets you select wireless receivers for text messages by Name and by Group. To do this, you must first create the following three messaging database directories (Wireless Messaging Service, Wireless Receivers, and Group) in the following order:

1. Building Your Wireless Messaging Services Directory
2. Building Your Wireless Receiver Directory
3. Building Your Group Directory (Optional)
These directories contain information about messaging service companies, individual wireless receiver numbers, and grouped listings of receivers that you wish to send text messages to as a set (such as a sales team or emergency action group).

Also note, you can always send a message manually by wireless receiver number (See “Sending Messages By Receiver Number” on page 50 for more details).

Building Your Wireless Messaging Services Directory
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The Wireless Messaging Service Directory XE "Messaging Service Directory"  is a database of messaging companies, including information on each company’s wireless messaging service number (and related communications information). AlphaPage First Responder allows you to set up as many wireless messaging service entries as you require.

You will need a separate entry for each different company used by those wireless receivers you wish to message—for example, if you are sending messages to one wireless receiver using a nationwide messaging service and to another using a local messaging service, you will need to create two messaging service directory entries.

There are two messaging service setup methods. To quickly add a new modem-based wireless messaging service, you can use the "Add a Messaging Service" wizard. For more advanced setup options, or to edit an existing messaging service, you can manually edit the service’s configuration.

To access either setup method, select “Messaging Services...” from the Edit menu to open the Listing of Messaging Services screen, which lists all currently defined wireless messaging services and their current call and packet counts. From this screen you can add, modify, or delete a messaging service.

Manually Adding or Editing a Messaging Service

From the Listing of Messaging Services screen you can add a new service or edit an existing service. To add a new service, click on the New button. To edit an existing service, select the messaging service you wish to edit and then click on the Edit button. The Messaging Service Setup screen will open.
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CONSULT YOUR MESSAGING SERVICE for their system’s connection method – dial-up or internet. 

· Dial-up (TAP) connection is also sometimes called a Access Number, Terminal Number, Modem Number, Alpha Port phone number, or Short Messaging Service phone number), optional system log-on password and for changes in any of the default communications parameters (Port Settings). 

· For Internet connections: SNPP & WCTP: Internet server address and port.

· For E-mail (SMTP): Consult your network administrator or ISP for Internet e-mail (SMTP) server address. Consult your Messaging Service for the e-mail address format of your wireless receiver for later entry of Receivers.

The Messaging Service Setup screen allows you to edit or create messaging service entries in the database.

The following are the Messaging Service Setup fields:

Messaging service name: Enter the name of the messaging service.

Password: If the messaging service requires a password, enter it here (most services do not require a password). Note that if a password is entered into this field and it is not required or is incorrect, a communications error can occur while logging onto the wireless messaging service’s system.

Maximum Message Length: Enter the maximum number of characters that your wireless messaging service can accept for a text message if it is different from the default setting of 80 characters. If you exceed the wireless messaging service’s maximum message capability, your message will typically be either truncated and partially sent or not sent.

Log messages to this service: If you wish for a log to be kept of all messages sent to this service, select this checkbox. (See “Message Logging” on page 66 for more information.)

Note: Message logging can also be turned on for individual receivers in the Wireless Receiver setup (See “Building Your Wireless Messaging Services Directory” on page 28.)

Connect to this paging service via: There are five connection methods supported – Modem Dial-up (TAP) connection, Internet (SNPP) XE "SNPP" \r "D2HBSNPP26" , Internet E-mail (SMTP), Internet (WCTP), and Direct Connection (via leased line modem or serial connection). Check with your messaging service if you are unsure of the connection method to use. 

Note: Internet E-mail (SMTP) is not a direct connection to the Messaging Service. Internet E-mail (SMTP) utilizes the Internet E-mail routing system, and as such long delays could result. Do not use Internet E-mail (SMTP) for time critical messages.

Settings: The settings area of the dialog changes depending on the connection method chosen (Dial-up, SNPP, SMTP, WCTP or Direct Serial). See “Messaging Service Connection Settings” for details on setting up each of the available connection methods.

Messaging Service Connection Settings

Depending on the connection method chosen, the setup options listed in the settings area of the Messaging Services setup screen vary. Listed below are the setup options for each connection method:

Modem Dial-up  (TAP) Connection
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Country: Select the proper country for this phone number.

Area Code: Enter the phone number’s area code.

Phone Number: Enter the messaging service phone number. Use of commas in the service phone number delays the dialing sequence by two seconds per comma. This is helpful for accessing an outside line in some telephone systems. Note that in most cases commas should be entered in your Windows Dialing Properties settings, and not in this field.

Use Area Code, Country Code, and Dialing Properties: If this checkbox is not selected, only the phone number will be dialed – the area code and country code will not be dialed. Use this only if you have a special dialing sequence that cannot be defined in the dialing properties.

Use Wizard: This button opens the "Add a Messaging Service" wizard.

Port Settings: This button allows you to change the communications properties for this connection. The default settings should work with most messaging services – change these settings only if you know that your messaging service requires special settings.
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Internet (SNPP) Connection
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Server Address: Enter the Internet address of the SNPP wireless messaging server. (Example: snpp.alphatech.com)

Port Number: Enter the port number of the messaging server (usually 444).

Login ID: If your messaging service requires a login ID, enter the login ID here (usually the login ID is left blank).

Internet E-mail (SMTP) Connection
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Note: Internet E-mail (SMTP) is not a direct connection to the Messaging Service. Internet E-mail (SMTP) utilizes the Internet E-mail routing system, and as such long delays could result. Do not use Internet E-mail (SMTP) for time critical messages.

E-mail server and Port: Enter the e-mail server address and port used to send Internet e-mail. Check with your network administrator or your ISP for the correct setting.

SMTP Authentication: If your outgoing mail server requires Authentication enter the logon information.

Internet (WCTP) Connection
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Server address and Port number: Enter the Internet address of the WCTP wireless messaging server. (Examples: www.InfoRad.com/wctp; wctp.InfoRad.com; wctp.InfoRad.com/wctp)

DTD Address: If your WCTP Service requires a special DTD address, enter their DTD address. Most providers use the default provided.

Use Secure HTTP: Selecting this option will use Secure HTTP (SSL) for the connection to the WCTP Server. The Port number will change to 443 for HTTPS when selected and the Server address will use the “https://” designation on save.

WCTP Authentication: Most WCTP Services do not require Authentication. If your WCTP Provider requires Authentication enter your logon information. (Note: Verizon Wireless Messaging requires Authentication, and you must first register at: http://wctp.myairmail.com/wctpRegistration/jsRegistration.jsp
Direct Serial Connection
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Direct serial connection through: Select the COM port that will be used for the direct serial or leased-line modem connection.

Port Settings: This button allows you to change the serial communications properties for this connection. The default settings should work with most messaging services – change these settings only if you know your messaging service requires special settings.

Flow Control: The flow control settings allows you to enable/disable Serial Port flow control, and select between XON/XOFF (software) flow control, Hardware (RTS/CTS) flow control, and the default setting None (no flow control). Normally there is no need to change this setting.

[image: image22.png]Paging Service Port Se

] baud, [7 data, even pariy, Tstop v

FlowContl [None <] Carcel
Duscmemsnm HUstommmm  —a2]

ttings.





The "Add a Messaging Service" Setup Wizard

The "Add a Messaging Service" Setup Wizard helps guide you through the process of setting up a dial-up modem connection to a new wireless messaging service. To set up an Internet connection to a messaging service, please refer to “Manually Adding or Editing a Messaging Service” on page 29.

To start the wizard, select "Messaging Service..." from the Edit menu to open the Messaging Services Setup screen, then click on the New button. When the Add Messaging Service dialog appears, click on the Wizard button. 
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To begin using the wizard, click on the Next button.

1. You are first prompted to enter a name for the messaging service you wish to add. Enter the name of the messaging service company, and click on Next to continue.

2. You are then prompted to enter the phone number of the wireless messaging service’s system (also sometimes called a Access Number, Terminal Number, Modem Number, Alpha Port phone number, or Short Messaging Service phone number). Your modem connects with this number and then relays the wireless receiver numbers and associated text messages that you wish to send.

Enter the messaging service’s number. When you have entered a messaging service number, click on Next to continue.

3. Next, enter the maximum number of characters that your messaging service can accept for a text message if it is different from the default setting of 80 characters.

Note: If you exceed the messaging service’s maximum message capability, your message will typically be either truncated and partially sent or not sent.

4. Next, select the baud rate that is used by your wireless messaging service. Usually, this is either 300, 1200, or 2400 baud. If you do not know the baud rate, use the default setting of 1200 baud. Click Next to continue.

5. The messaging service setup is complete. Click on Finish to add the new messaging service to the AlphaPage First Responder messaging database or click on “Add another messaging service” if you wish to repeat the wizard.

Building Your Wireless Receiver Directory

You should  have already set up at least one messaging service before entering new receivers. (See Building Your Wireless Messaging Services Directory for details.) \definition "messaging service" 
AlphaPage First Responder provides for easy entry or changes in your wireless receiver directory. The directory allows you to setup as many receivers as you require, and each receiver name entered can be assigned to any previously programmed messaging service. The AlphaPage First Responder alphabetical search feature will quickly zoom you in on a receiver to view/modify and will also help you select from your messaging service directory. XE "Messaging Service Directory" 
There are two receiver entry setup methods, the “Add a Receiver” setup wizard and the Wireless Messaging Receivers screen. To quickly add a new wireless receiver, you can use the “Add a Receiver” Setup Wizard. For more advanced receiver setup options, or to edit an existing receiver entry, use the Wireless Messaging Receivers screen.

To access either method, select “Receivers...” from the Edit menu. This will open the Wireless Messaging Receivers screen, which lists all defined wireless receiver numbers, who carries the receiver, and the appropriate messaging service.
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From the Wireless Messaging Receivers screen you can add, modify, or delete wireless receiver information from the AlphaPage First Responder receiver directory.

Route on Failure option
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The Route on Failure feature in AlphaPage First Responder allows the addition of an Alternate Receiver or Alternate delivery method in the event of a failure when sending to the Primary Receiver. For example, if the Internet connection is down, the  message can be routed to the Dial-up TAP Service for delivery. Another option might be routing the message to an alternate Receiver different from the Primary Receiver, for example, route the pager message to the persons cell phone or PDA. The Alternate Receiver could even be a different persons wireless receiver, if desired.

Note that the program will use the Retries settings in Failed Message Retries in Preferences when attempting to deliver to the Primary receiver before rolling over to the Alternate Receiver to attempt delivery.

To utilize the Route on Failure feature for a Receiver, simply check the ‘Route to alternate receiver’ option, and enter the appropriate Receiver ID and Messaging Service for the Alternate Receiver.

Please note that Alternate delivery methods may have a different Receiver ID. For example, the Receiver ID when using an Internet service may require the 10-digit phone number, and the Dial-up service may require the 7-digit phone number; if the Primary delivery is e-mail the Receiver ID is the e-mail address, and the Alternate delivery may require the 7- or 10-digit phone number. 

Manually Adding or Editing a Wireless Receiver
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The Wireless Receiver Setup screen allows you to enter a new receiver’s information or edit the settings for an existing wireless receiver.

To access the Edit Wireless receiver screen, select "Receivers..." from the Edit menu or click on the Receivers button XE "Edit User button" \r "D2HBReceivers_bu32"  in the toolbar to display the Wireless Receivers Setup screen.

From this screen you can add or edit a wireless receiver’s settings, including the name of the person carrying the wireless receiver, the wireless receiver’s phone or PIN number or e-mail address, and the wireless messaging service used by the wireless receiver. You can also specify if wireless receiver messages sent to the wireless receiver will be logged or not, and whether to utilize the Route on Failure option to send failed messages to an Alternate Receiver. (See “Route on Failure option” on page 39 for more information.)

Adding a New Wireless Receiver

1. When the Listing of Receivers screen appears, click on the New button.

2. Enter the person’s name carrying the wireless receiver.

3. Tab or click to the next line and fill in the wireless receiver number.

Note: For Wireless Receivers utilizing a ‘modem dial-up (TAP) connection, enter either the pager’s PIN number or phone number as required by your messaging service, but DO NOT include the area code. (An exception for this rule would be if you are dialing in to a single, central TAP connection for a Messaging Service, versus individual TAP connections by city – then use the 10 digit phone number with area code.) 

If you are using internet paging (SNPP, WCTP, SMTP) use the 10-digit phone number (including the area code) or the PIN number of the Receiver.

For PCS phones enter the phone number including the area code.  

4. Click on the appropriate wireless messaging service. If you wish to add a new wireless messaging service, click on the Add button.

5. Optionally, you can enable message logging XE "Message Logging" \r "D2HBMessage_Logg32" 

 XE "Logging" \r "D2HBMessage_Logg32"  for this receiver.

6. Check the ‘Route to alternate receiver’ box if you wish to utilize the Route on Failure feature for this Receiver. Enter the Receiver ID and Messaging Service for the Alternate Receiver. (See “Route on Failure option” on page 39  for more information.)

Note: You can also select the message logging options when setting up your messaging service directory, XE "Messaging Service Directory"  to log all messages sent to a specific messaging service. (See “Building Your Wireless Messaging Services Directory” on page 28 for more information.)

7. When all the information is correct, click OK.

Editing an Existing Wireless Receiver

To view or edit information about a Wireless Receiver later, select Wireless Receivers from the Edit menu.

1. Select the Wireless Receiver you wish to edit from the list and click on the Edit button or double-click on the name. The system automatically displays the receiver information you entered earlier.

2. Tab down or click to any line and change the entry by typing over it or clicking the drop down to select the setting you want.

3. Click OK to save your changes.

The "Add Wireless Receiver" Setup Wizard

The "Add Wireless Receiver" Setup Wizard helps guide you through the process of adding a new wireless receiver to your messaging database.

To use the wizard, select "Receivers..." from the Edit menu or click on the Receivers button in the toolbar.

Click on the Add button to open the Wireless Receiver Setup screen, then click on the “Use Wizard” button.
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1. You are first prompted to enter a name for the new wireless receiver. Enter a name and click on Next to continue.

2. You are then prompted for the receiver’s personal ID number (PIN) or wireless receiver number. Enter the wireless receiver number or PIN and click on Next to continue.

Note: For Wireless Receivers utilizing a ‘modem dial-up (TAP) connection, enter either the pager’s PIN number or phone number as required by your messaging service, but DO NOT include the area code. (An exception for this rule would be if you are dialing in to a single, central TAP connection for a Messaging Service, versus individual TAP connections by city – then use the 10 digit phone number with area code.) .  

If you are using internet paging (SNPP, WCTP, SMTP) use the 10-digit phone number (including the area code) or the PIN number of the Receiver.

For PCS phones enter the phone number including the area code

3. Next, select the messaging service used by the receiver. If their messaging service is not listed, you can click on the "Add…" button to start the "Add a Messaging Service" wizard and enter their messaging service into the database. When you have selected the receiver's messaging service, click on Next to continue.

4. The new receiver setup is complete. If you wish to add another receiver, click on the “Add another receiver” button. Click on Finish if you are done using the Add Wireless Receiver wizard.

Note: If you later wish to edit this receiver's settings or add an Alternate Receiver for Route on Failure, you can use the Wireless Receiver Setup screen to make modifications (See “Editing an Existing Wireless Receiver” on page 41 for details).

 XE "Group Directory" Building Your Group Directory (Optional)

Wireless receivers can be grouped together so you can send messages to a number of people simultaneously. When a group is messaged, AlphaPage First Responder automatically sorts and combines all messages in the messaging dispatch queue according to their messaging service. This eliminates redialing and speeds up the messaging process when you have a large number of people to send messages.

To create a messaging group, select “Groups...” from the Edit menu. The Listing of Groups screen appears.

The Listing of Groups screen lists all of the defined messaging groups. From this screen you can add a new group or modify an existing group.
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Adding a New Group

1. From the Listing of Groups screen, click the New button.

2. Enter a name for the new group.

3. To add a receiver, select that receiver from the “Available receivers” column and press “<< Add”.

4. To remove a receiver, select the receiver in the “Group Members” column and press “Remove >>”.

5. Repeat as needed to add additional receivers. When you are finished adding receivers to the group, click on Ok.

Note: AlphaPage First Responder allows up to 500 Group members.

Modifying a Group

1. From the Listing of Groups screen, select the messaging group you want to modify and select the Edit button.

2. To add a receiver, select that receiver from the “Available receivers” column and press “<< Add”.

3. To remove a receiver, select the receiver in the “Group Members” column and press “Remove >>”.

4. When you are finished adding or removing receivers to the group, click on Ok to save the changes to the group.

Note: AlphaPage First Responder allows up to 500 Group members.

Sending Wireless Messages

 XE "Messaging: Overview" Wireless Messaging Overview

Sending wireless messages is possible once you have built your receiver and messaging service directories.

There are two main methods of messaging:

· Sending Messages by Name or Group
· Sending Messages By Receiver Number
In addition, there are several options available with each of these messaging methods, such as scheduled messages XE "Scheduled Messages" 

 XE "Messaging: Scheduled"  and predefined messages. XE "Predefined Messages" 

 XE "Custom Messages"  For details on messaging options, please refer to “Message Options” on page 51. 

Sending Messages by Name or Group

1. In the “Select message recipients” window, click on the name of the person or group you wish to send a message to or type in the first few letters of the name.

Groups have a group icon [image: image30.bmp] displayed next to the group name in the receivers list.

(If you have not set up any receivers yet, please see “Building Your Wireless Receiver Directory” on page 38.)

To choose a different name, just use the arrow keys or click on the new name to select it.

Note: You can message more than one person or group at a time (creating a temporary or “ad-hoc” group) by selecting multiple names from the list. To select more than one name, hold down the Control (or Ctrl) key when clicking on additional names. Also, the Shift key can be held down to select a range of names (from the currently selected name to where you click).
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2. Once you have selected the recipients, press Tab to move to the “Type message” window to begin typing your message. The message you enter will be sent to all selected individuals and groups. (If you plan on often sending messages to the same group of individuals, you should set up a messaging group. See “Building Your Group Directory (Optional)” on page 44 for more information.).

A character and number of pages counters are visible above the message entry area. Messages can be up to 1024 characters long and can be optionally auto-split into several pages depending on the capacity of the messaging service and receiver you are using. To correct typing mistakes, use the Delete or Backspace keys to type over existing text. Also, you can use your mouse to move around within your message.

Note: You can also enter messages from other documents using Windows copy (Ctrl+C) and paste (Ctrl+V) functions. Just copy the desired text, and paste it into the message input screen. 

3. When your message is complete, click on the Send button to send the message. When Send is selected, AlphaPage First Responder will inform you of its progress in sending your message. Optionally, you can queue the message for batch sending, or schedule when the message will be sent (See “Message Queue” on page 58 and “Scheduled Messages” on page 57 for details).

 XE "Sending Messages: by Receiver Number" 

 XE "Messaging: by Receiver Number" Sending Messages By Receiver Number

AlphaPage First Responder allows you to send messages manually, without first defining a receiver. This is useful for one-time messaging needs, when you do not wish to add the receiver number to your directory.

1. Enter the message you wish to send or use the Options menu pull down to select the previous message XE "Previous Message" \r "D2HBPrevious_Mes41"  and other options. A character counter is visible above the message entry area. Messages can be up to 1024 characters long and can be optionally auto-split depending on the capacity of your messaging service and the receiver you are using. (See “Preference Options” on page 22 for more information.)

2. Click on the Options button under the type message window, then select “Send to unlisted receiver.” The Send to Unlisted Receiver screen will appear.
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3. Enter the ID number of the receiver you wish to send to.

Note: For PCS phones enter the phone number including the area code. For text pagers, enter either the pager’s PIN number or phone number as required by your messaging service, but DO NOT include the area code, unless you are using internet  paging, which may require a 10-digit pager phone number (including the area code) or PIN number.

4. Click on the drop down box and select a messaging service, or enter the messaging service phone number. Click on Ok.

5. When your message is complete, press Enter or click on the Ok button to send the message. AlphaPage First Responder will inform you of its progress in sending your message.

 XE "Message Options" Message Options

AlphaPage First Responder offers you several different options for text message input, including the following:

· Signature 

· Predefined Messages
· Previous Message (Last Message Recall)
· Template Messages
· Scheduled Messages
· Queue Message (See “Message Queue” on page 65 )

· Send to unlisted receiver (See “Sending Messages By Receiver Number” on page 50 )

These options are available by selecting them from the Options button drop-down menu.
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Signature

If you wish to include your message signature with a message, click on the Options button below the message entry area, select Signature, and then select whether you’d like the signature placed before or after the message.
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If either of these options is selected, your signature message will automatically be included with each message you send.

Note: Your message signature will not be displayed while you enter your message, but will be included with the message when it is sent.

(See “Preference Options” on page 22 for details on setting up a message signature). If you include your message signature, the character count for the message will include the number of characters in your signature.

 XE "Predefined Messages" \r "D2HBPredefined_M44" 

 XE "Custom Messages" \r "D2HBPredefined_M44" Predefined Messages

AlphaPage First Responder allows you to define up to 500 common messages into a custom list that can be easily accessed from the message input screen. To view or create a predefined message, click on the Options button under the message input window and then select the Predefined Message menu.
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To send a predefined message, select the message you wish to send from the Predefined message menu. The message text is entered into the message input window, where it can then be modified and sent as an ordinary wireless receiver message.

To create a new predefined message or edit an existing predefined message, select “Edit predefined messages” from the Predefined message menu.

The Predefined Messages dialog will appear.
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The Predefined Messages dialog allows you to add, edit, or delete custom messages. The list of predefined messages can be listed alphabetically, or by the number of times each message has been used.

· To create a new predefined message, click on the Add button, then type in the new message you wish to save.

· To edit a message, first highlight the message you wish to modify and then click on the Edit button.

· To delete a message, click on the message you wish to delete and then click on the Delete button.

Previous Message (Last Message Recall)

You may want to repeat your last message entered, either to the same recipient or to someone else. AlphaPage First Responder allows you to access any of the last 10 messages sent.

To send a previous message, first select the Wireless receiver Name or Group that you want to send the message to.

To recall the text of a previous message, click on the Options button and then select the Previous Message menu.
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A list of previous messages will be displayed. If you wish to delete all previous messages from the recall menu, select the “Clear list” option.

Select the desired previous message from the list. The message is entered into the message input window, where it can now be edited as needed for the new message.

When the new message is correct, click on the Send button to send your message.

 XE "Scheduled Messages" \r "D2HBScheduled_Me46" 

 XE "Messaging: Scheduled" \r "D2HBScheduled_Me46" Template Messages XE "Template Messages" 
AlphaPage First Responder allows you create and utilize Template Messages. Template messages are predefined messages with entry fields for the sender. For example, a job dispatch template. AlphaPage First Responder installs several sample templates as examples. 

Please see Addendum T for instruction on creating and using Template Messages:

· About Message Templates on page 88
· Creating Message Templates on page 89 
· Message Template Reference on page 92
To use a template for messaging, select the Receiver(s) or Group(s) to receive the message, then on the Options menu select ‘Template message’.
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A listing of available templates will be displayed. Select the template you wish to use from the list.
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The selected template will be displayed. An example is shown below.
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Enter the required information into the template fields. Then select the ‘Send’ button to send the message immediately, or select the ‘Schedule’ button to schedule the message for sending later.

 XE "Scheduled Messages" \r "D2HBScheduled_Me46" 

 XE "Messaging: Scheduled" \r "D2HBScheduled_Me46" Scheduled Messages

AlphaPage First Responder allows you specify up to 500 messages to be sent at a specific time and date, if necessary.  This allows you to send messages as meeting or appointment reminders. If you have entered your own receiver information into AlphaPage First Responder, you can even send yourself scheduled reminders. 

To schedule a message, simply create a message as you normally would, then click on the Options button under the message input window and select the “Schedule message…” option from the Options menu to bring up the Scheduled Message dialog.
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From this dialog you can set the time and date that you would like the wireless receiver message to be sent.

Once you have selected a date and time to send your message, click on the OK button to place your message in the scheduled messages queue. The scheduled messages queue can be viewed by selecting Scheduled Messages from the List menu.

Note: AlphaPage First Responder will warn you if there are any scheduled messages pending when you try to exit the program. AlphaPage First Responder cannot send a scheduled message if the program is not running at the specified date and time. If the software is not running when a message is scheduled to go out, the message will be processed the next time AlphaPage First Responder is started according to the Scheduled Messages option in Preferences setup on page 24.

Recurring Scheduled Messages XE "Recurring Scheduled Messages" 

 XE "Recurring Scheduled Messages" 
AlphaPage First Responder includes an Advanced Scheduler allowing for Recurring Scheduled Messages. Messages can be set to recur on a Daily, Weekly, or Monthly schedule.  

To schedule a Recurring Message, simply create a message as you normally would, then click on the Options button under the message input window and select the “Schedule message…” option from the Options menu to bring up the Scheduled Message dialog, then select one of the Advanced Schedule Options (Daily, Weekly, Monthly) from the ‘Message will be sent’ option drop down.
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Every xx day(s): Select how many days (1-365) between sending the message.  


Example: Choose 1 day for every day. Choose 365 days for once a year.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message will continue as scheduled until deleted from the Scheduled Messages list.

Weekly options:
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Every xx weeks(s): Select how many weeks (1-52) between sending the message.  


Example: Choose 1 week for every week. Choose 26 weeks for twice a year.

Days of the Week: Select the day(s) of the week to send the message.                                       Example: The message can be sent  one day a week, several days a week, weekdays only, or weekends only.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message will continue as scheduled until deleted from the Scheduled Messages list. Note that the end date will be adjusted automatically when the schedule is saved according to the last time the message can be sent under the selected schedule.

Monthly options:
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Day of the month: Select the day of the month (1-31) between sending the message.  


Note: If the day of the month selected is greater than the 28th, a warning dialog will pop up stating that no message will be sent in any months that do not have that number of days in the month. See next option for Last Day of Month option.
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The xx xx of the month: Select first, second, third, fourth, or last and the day of the week (Monday – Friday) to send the message.                                                                                                          Example: The message can be sent  the second Tuesday of every month, or the last Friday of every month.

Note: A special option for the “last day of the month” has been programmed. The “last day”  of the month option is only available when “last” is selected in the first drop down list of this option.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message will continue as scheduled until deleted from the Scheduled Messages list. Note that the end date will be adjusted automatically when the schedule is saved according to the last time the message can be sent under the selected schedule.

 XE "Scheduled Messages" \r "D2HBScheduled_Me46" 

 XE "Messaging: Scheduled" \r "D2HBScheduled_Me46" Scheduled Messages Queue XE "Scheduled Messages Queue" 
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The Scheduled Message Queue XE "Message Queue" \r "D2HBMessage_Queu47" 

 XE "Messaging: Message Queue" \r "D2HBMessage_Queu47"  window lists all upcoming scheduled messages. From this window you can view, change, or delete any or all of the currently scheduled messages. 

Note: AlphaPage First Responder will warn you if there are any scheduled messages pending when you try to exit the program. AlphaPage First Responder cannot send a scheduled message if the program is not running at the specified date and time. If the software is not running when a message is scheduled to go out, the message will be processed the next time AlphaPage First Responder is started according to the Scheduled Messages option in Preferences setup on page 24.

Edit Schedule: Change the scheduled time, date, or recurrence settings of the message.

Edit Message: Change the text of the message.

Delete Selected: Delete the selected message(s) from the list. Recurring Scheduled Messages will give you the option to delete just  the next scheduled delivery or all remaining occurences.
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Delete All: Deletes all scheduled messages in the list.
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Message Queue

When you select “Queue message” from the Options button menu after entering a message, AlphaPage First Responder automatically creates a Message Dispatch Queue, a holding line for messages waiting to be sent. This queue can be edited, allowing you to remove messages before they are sent.

When there are messages in the Message Dispatch Queue, the Send Queue and Edit Queue options under the Queue menu become active. If you select Edit Queue from the Queue menu, the Message Queue screen will be displayed.
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In the Edit Queue screen you can selectively highlight and delete from the queue individual messages or all messages in your dispatch queue.

To mark a message for deleting, click on the message line. To delete all marked messages click on the "Delete selected" button.

Note: You can select more than one message at a time to delete. To select more than one message, hold down the Control (or Ctrl) key when clicking on pages, or use the Shift key to select a range of messages (from the currently selected message to where you click).

Click on OK to close the Edit Queue screen and return to the main screen when you are done with editing or viewing the queue.

 XE "Message Logging" 

 XE "Logging" Message Logging

You can log all messages going to a wireless receiver, including a time/date stamp. You can select your logging preferences when creating or editing a Receiver or Messaging Service directory XE "Messaging Service Directory"  entry. Logging functions, when selected under a wireless messaging service name, affect any receiver entries that use that particular wireless messaging service.

When you select “Logged Messages” from the List Menu, the Logged Messages dialog is opened. From this window you can view, copy, delete, and print the information stored in your log files.
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Today's messages are displayed by default. To view log messages for another date range, enter the date range you wish to view then press Enter or click on the Update button. The logged messages are summarized by the name of the person they were sent to.

If you wish to view specific messages sent to a individual, click on that person in the list and then click on the Details button. All of the logged messages sent to that specific person are then listed, including any errors that occurred when trying to send those messages.

To see the full text of any of the messages, simply click on that message. The text will be shown in the Full Message Text box. If you wish to copy the information, click on the Copy to Clipboard button. To delete all messages in the displayed date range, simply click on the Delete button.

A Note About Log Files

When information is logged on the hard disk, it is generated as a daily file in the AlphaPage directory, such as “NOV30_05.LOG”. In addition to viewing log files from within AlphaPage First Responder, you can also use Windows Notepad or any word processing program to view or print logged messages. Remember to purge your log files occasionally, to conserve hard disk space.

 XE "Directory Maintenance" \r "D2HBLast_Message42" Directory Maintenance

 XE "Directory Listings" \r "D2HBLast_Message42" Directory Listings

AlphaPage First Responder allows you to print your directory information, including detailed messaging information, such as the number of messages and packets sent. You can generate directory listings organized by Receiver name, Receiver number, Group name and Messaging Service. To view a directory listing, select the desired type of directory (Receivers, Groups, or Messaging Services) from the Edit menu.

If the directory listing display contains more information than can be displayed on the screen at one time, a scroll bar will appear on the right side of the listing so you can move through the listing.

To sort the directory listing, click on the title of the column you would like to sort by. To invert the sort order, click on the column title again.

To make a hard copy of the displayed directory information, click on the Print button. When you are finished viewing the listing, click Ok.

 XE "Message and Packet Counts" Clearing Message and Packet Counts

Once you have displayed and printed your listing, you may want to clear the message and packet counts. You can clear counts for an individual wireless receiver by clicking the name of the individual and then clicking on Clear Counts. If you click Clear All Counts, the system zeros all the counts in the listing. When you are finished with the directory listing, click OK.

Note: A wireless receiver’s call count is recorded in increments of one per each message sent. The packet count is incremented by one per every 20 characters of message per message sent.

 XE "Removing Directory Entries" 

 XE "Directory Entries" Removing Directory Entries

1. Select the directory you wish to change (Receiver, Group or Messaging Service) from the Edit menu.

2. Once the desired Edit screen is displayed, select the entry you wish to delete and click Delete to remove the entry.

 XE "Backing Up Directories" 

 XE "Restoring Directories" 

 XE "Directory Backup and Restore" Backing Up and Restoring Directories

AlphaPage First Responder offers you the ability to backup and restore your directory database files. You can use this feature for backup and to transfer directory information.

Backing Up Your Directories

To backup your directory information:

1. Select “Save Program Files To” from the File menu. You will be prompted for a directory to backup the database files.

2. Select the directory or drive that you wish to save the backup files. Do Not select the AlphaPage First Responder directory.

Restoring Your Directories

To restore your directory information:

1. Select “Load Program Files From” from the File menu. You will be prompted for a directory where the backup files are located.

2. Select the File Types that you wish to restore:
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All Program Files –  Loads Database files, Predefined and Scheduled Messages files

Database Files – Loads Database Files ONLY

Message Templates – Loads Message Template files ONLY (*.tml)

Predefined Messages – Loads Predefined Message file ONLY

Scheduled Messages – Loads Scheduled Message file ONLY

Legacy Database Files – Loads Database Files from InfoRad versions 10.0 and prior
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(Note that Legacy Database files will not be listed in the Load Program Files Browse dialog unless the Legacy Database Files option is selected.) 

3. If you currently have database files, AlphaPage First Responder will ask if you are certain you wish to replace the current files. Click Ok to load the backup files.

 XE "Exiting" Exiting AlphaPage First Responder

To Exit AlphaPage First Responder, select Exit from the File menu or click on the close box in the upper right-hand corner of the main screen. If you try to exit AlphaPage First Responder while there are messages in the message dispatch queue or scheduled messages, XE "Scheduled Messages" 

 XE "Messaging: Scheduled"  AlphaPage First Responder will warn you of their presence. You can choose to return to the Message screen or exit without saving the message queue. XE "Message Queue" 

 XE "Messaging: Message Queue" 
Background Messaging XE "Background Messaging" 
If you want to send the messages without maintaining AlphaPage First Responder in the foreground, select Send or Send Queue from the Queue menu. AlphaPage First Responder will continue running in the background and your messages will be dispatched while you resume other tasks.

 XE "Solving Problems" 

 XE "Problem Solving" Solving Problems

 XE "Technical Support" Technical Support

If you are having problems , first make certain that AlphaPage First Responder is configured properly:

· Setup Options
· Building Your Wireless Messaging Services Directory
Please review the following troubleshooting sections first to assist you with the AlphaPage First Responder software system:

· Installation Problems
· Error Codes

Should you require additional assistance with AlphaPage First Responder, please briefly document your problem and questions, serial number and version number. 

Technical Support Options

Technical Support is only available to registered users of the software as detailed in the licensing agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support XE "Technical Support" \r "D2HBTechnical_Su6"  included. AlphaCare Subscription optionsxe "Support"

xe "Technical Support" are available that extend the support period, as well as offer priority telephone support and Upgrade Protection. Out-of-warrantyxe "Warranty" support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at www.inforad.com/techsupport
Phone:
(216) 531-1369

E-mail:
Techsupport@inforad.com

Internet:
www.inforad.com

Installation Problems

If you are having problems installing AlphaPage First Responder, check the following:

1. AlphaPage First Responder installs to any drive and runs from any drive assignment. The standalone version of AlphaPage First Responder supports local drives only. The network version of AlphaPage Wireless supports local or network drives. 

2. To install AlphaPage First Responder in Windows 95, Windows 98, Windows ME, Windows NT 4.0, Windows 2000, and Windows XP  click on the Start button and select Run. Type in x:SETUP in the Open: line and click OK. (where x is the floppy or CD drive that contains the AlphaPage Wireless Office installation disk.  

Note: Web downloaded products consist of a single installation file, simply run the downloaded executable (.exe) file.

3. AlphaPage First Responder only requires 4mb of hard disk space for normal operation. Make sure that you have sufficient hard disk space for the installation.

 XE "Error Screen" \r "D2HBInstallation53" 

 XE "Failed Messages Screen" \r "D2HBInstallation53" Failed Messages Error Screen

The Failed Messages Error screen lists all messaging errors that have occurred, including the type of problem, the probable cause of the problem, and any messages from the messaging service. You can scroll through the errors to examine each error.
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To cancel a message, click on the message line for that message. To cancel all messages click on the “Cancel All” button.

Note: You can select more than one message at a time to cancel. To select more than one message, hold down the Control (or Ctrl) key when clicking on the messages, or use the Shift key to select a range of messages (from the currently selected message to where you click).

To try and send the messages again, click on the “Try again now” button. If you wish to postpone AlphaPage First Responder from attempting to send the messages again, click on the “Try again Later” button. This moves the messages back into the send queue, where they can be sent at a later time by selecting “Send Queue” from the Queue menu on the main screen.

 XE "Error Codes" Error Codes

There are several categories of error codes, each related to the type of error that occurred. The following sections list each category of error codes and the error codes contained within that category:

 XE "Local Errors" 

 XE "Errors:Local" Local Errors

Local errors are errors that are the result of problems with the local computer; that is, the one AlphaPage First Responder is running on.

For local errors, check the following:

· Make sure the modem is properly connected and turned on.

· Verify your modem selection, advanced settings, and other modem options are correct in Communications Setup. 

· Check to see if any other communications program is currently using your modem or hasn’t properly disconnected from it.

· Reset or power down your modem. If it is an internal modem, power your system down and reboot.

(1104) Local Error: Could not access modem

This means AlphaPage First Responder tried to open the comport and could not get a response from the modem. This could be because the port could not be opened (port was busy, or does not exist) or because the modem did not respond (modem was turned off, or is on another port, etc.).

(1105) Local Error: Line is not available

This means that the line device selected for sending pages is unavailable. Usually this means that the line is in use by some other application.

 XE "Remote Errors" 

 XE "Errors:Remote" Remote Errors

Remote errors are what happens when the remote system (the wireless messaging service) reports a specific error or when there is difficulty communicating with the wireless messaging service. These errors happen after a connection with the messaging service has been established. 

(1201) Remote Error: Could not handshake with service

AlphaPage First Responder was able to CONNECT to the answering modem, but is receiving no further response from the messaging service.

· Check to insure the messaging service modem access number is correct. Note that it may also be called the Terminal phone number, Alpha Port phone number, Access number, or PCS short messaging service (SMS) phone number.

· Check the messaging service communication parameters – Baud Rate, Data Bits, Parity, and Stop Bit. (Note: Most wireless messaging services are 1200 Baud, sometimes 2400 or 300; and are almost always 7 data bits, even parity, 1 stop bit.)

· Check the modem selection in the Communications Setup for proper modem type.

· Select “Override” in the Modem Configuration XE "Modem: Initialization String"  dialog, and then click on the Create button to build a unique initialization string for your modem.

· Reference the ‘Using High Speed and Fax modems’ section of the manual or on-line Help and your modem’s manual (reference AT command section) to construct a modem initialization string for your modem.

· Check with your modem manufacturer to insure your modem supports the wireless messaging service Baud Rate and data settings (Ex: 1200, 7, even 1).

(1202) Remote Error: Service did not respond to message

The wireless messaging service did not return any response code after AlphaPage First Responder sent a data block; generally a result of a poor connection, or can be a problem at the messaging service.

· Retry sending the message(s).

· If received when sending multiple messages, check with your wireless messaging service for any limit on the number of messages that can be sent in a single dial-up session.

(1203) Remote Error: Message was not acknowledged

The wireless messaging service responded to a data block with the NAK code. 

· Retry sending the message.

· Remove the area code from the wireless receiver ID number (text pagers).

· Verify the proper wireless receiver ID number is entered.

· Use the wireless receiver’s PIN number. 

(1204) Remote Error: Forced to abandon by service

The wireless messaging service responded with the abandon code. This means the wireless messaging service is rejecting the message.

· A “[P” in error messages in the Failed Messages error screen XE "Error Screen" 

 XE "Failed Messages Screen"  indicates that the program is starting to send the message – if disconnects occur at this point it usually indicates an invalid wireless receiver ID number.

· Verify that the proper wireless receiver number is entered. Sometimes wireless receivers are assigned two numbers. One number for numeric messaging from a phone and another for the wireless receiver identifier when remote messaging (PIN number). Verify with your wireless messaging service which number to use.

· You may need to verify with the wireless messaging service that the wireless receiver number is activated, programmed for text or short messaging (not numeric-only messaging), and that you are using the correct service number for text messaging.

· If you are using a dialup modem connection, verify that there is no area code in the pager number. If you are using an internet connection, verify that the area code is included.

· Verify that you are dialing the correct service number for your wireless receiver—messaging companies sometimes have multiple service numbers, and your wireless receiver ID number must be valid on the system to which you are connecting.

· Some messaging companies will reject messages if the message is too long. Try sending a short message. If it successfully sends, verify the allowable message length with your wireless messaging service, and then set the message size in the wireless messaging service setup.

(1205) Remote Error: Service forced a disconnect

The wireless messaging service sent AlphaPage First Responder the disconnect code. This can happen when the service does not accept AlphaPage First Responder’s response to the login prompt.  

· Check that any password is valid in the Wireless Messaging Service setup advanced properties. (Note that most wireless messaging services do not require a password.)

· A “[P” in error messages in the Failed Messages error screen indicates that the wireless receiver ID # is incorrect—try and use the PIN number and not the wireless receiver phone number in the receiver’s ID Number field. Double-check the receiver ID to make sure it was correctly entered.

· Some messaging companies will reject messages if the message is too long. Try sending a short message. If it successfully sends, verify the allowable message length with your messaging company, and then set the message size in the wireless messaging service.

· Make sure the wireless receiver has been activated or not disconnected by the messaging company. Optionally, try messaging it from your phone as a numeric pager.

· Verify that you are dialing the correct access number for your receiver—wireless messaging services sometimes have multiple systems, and your wireless receiver number must be valid on the system to which you are connecting.

(1206) Remote Error: Invalid reply to login

The messaging service did not properly respond after AlphaPage First Responder’s login. 

· Retry sending the message.

· Check the data bits and parity settings (Messaging Service Advanced Settings).

· Check that any password is valid.

· Try changing the baud rate (Messaging Service Advanced Settings).

· Check the modem selection in the Communications Setup to ensure that the proper modem is selected.

· Select “Override” in the modem configuration, XE "Modem: Initialization String"  and click on the Create button to build a custom initialization string for your modem.

· Reference the ‘Using High Speed and Fax modems’ section of the manual or on-line Help and your modem’s manual (reference AT command section) to construct a modem initialization string for your modem.

· Check with your modem manufacturer to insure your modem supports the messaging service Baud Rate and data settings (Ex: 1200, 7, even, 1).

 XE "Communications Errors" 

 XE "Errors: Communications" Communications Errors

These errors report problems establishing or maintaining the link between the wireless messaging service and the local computer, whether the source of the problem is the wireless messaging service, the local computer, the phone network, or anything else.

(1301) Communications Error: Could not connect with remote modem

This appears when the phone was successfully dialed, but no “CONNECT” message was received.  Common causes are bad service phone numbers, bad modem initialization strings, bad modems (on either end), incorrectly installed modems (no dial tone) and so on.

· Verify that you correctly entered your messaging service phone number and parameters such as baud rate, data parity, and stop bits. You should always hear a high-pitched modem connection tone when dialing the correct number. If your modem speaker is turned off, try dialing the messaging service phone number from a telephone to verify that there is a modem connection tone when connecting.

· Verify your modem selection or custom init string. If you are using a Fax or high-speed modem disable the data compression and error correction features; see Using High Speed and Fax Modems section for more information.

· Verify that you are dialing the correct service number for your wireless receiver—messaging services sometimes have multiple service numbers, and your wireless receiver number must be valid on the number you are dialing.

· Verify your dialing location settings and selection.

· Check if the messaging service requires a password, and if so, verify that password (normally, messaging services don’t use a password).

· Double-check the custom modem initialization string, if the “override” option was used during modem setup.

· Make sure the modem isn’t attempting to connect to a fax number.

· The wireless messaging system may be experiencing technical difficulties. Check with your messaging service.

(1303) Communications Error: There was no dial tone on the dialing line

This appears when the local modem could not detect a dial tone, and so could not begin dialing.

· Verify the modem is correctly installed.

· Check to see if  the phone line is in use or is working properly.

· Verify that your modem has power, that you have dial tone at your modem, and that your phone line is plugged into the modem jack labeled “line.”

· Verify that your dialing location and options are correct (Windows “Telephony” or “Modems” control panels).

· Verify your modem selection.

· If you have a digital phone system, you may need to use a special jack to access an analog phone line. Plugging your modem directly into a digital phone system will not work, and may damage the modem or the phone system.

(1304) Communications Error: The called number was busy

This appears when the program has already redialed the service provider the specified number of times, and received a busy signal every time. 

· Verify the messaging service access number is correct.

· Check if the messaging service is busy or experiencing problems.

· Increase the re-dial on busy setting in Communications Setup, Advanced Modem Settings, Dialing Options. XE "Dialing Options" 

 XE "Setup: Dialing Options" 

 XE "Modem: Dialing Options" 
(1399) Communications Error

The generic communications error that appears when there is some problem reading data from the communications port.

· Check for any device conflicts.

 XE "TAPI errors" 

 XE "Errors:TAPI" 

 XE "Errors: Communications" TAPI Errors

TAPI errors report problems setting up and using the Windows telephony interface. These errors should represent problems that are specific to TAPI, and not to the process of sending pages in general.

For TAPI errors, unless specified below, check the following:

· Check other programs that utilize TAPI for a similar problem.

· Verify the TAPI setup/installation for the operating system.

· Verify that your system is using TAPI 1.4 or above.

· Verify that you modem is setup properly in the operating system.

· Check for any device conflicts.

· Check for any software conflicts.

· Try deleting the current modem configuration in the Modems Control Panel and then adding it back.

· Check your TAPI location selection and settings (dialing options) in the Windows “Telephony” or “Modems” control panels.

(1400) TAPI error: TAPI initialization failed

To start up TAPI, the program must load some TAPI / operating system DLLs. If the DLLs cannot be loaded, this error will appear.

(1401) TAPI error: Could not negotiate common API version

There are different versions of TAPI available. Windows 95 shipped with TAPI 1.4, Windows NT 4.0 shipped with TAPI 2.0, and Windows 98 shipped with TAPI 2.1, and TAPI 2.2 shipped with Windows 2000, XP, and 2003 Server. AlphaPage First Responder tells the system that it can support TAPI 2.0 and the system responds by enabling only the features available in that version. If there is some problem with this process (for example, if the system only supports TAPI 1.3 or lower), you may see this error. 

(1402) TAPI error: Unable to query TAPI address capabilities 

Before placing a call on a device, the program queries TAPI about the line’s capabilities. This message shows up when TAPI will not or can not respond to the request. 

(1405) TAPI error: Selected device does not support data calls

TAPI devices include modems, fax boards, ISDN telephones, and other devices, not all of which can transfer data the way modems can. Before sending messages, AlphaPage checks to be sure that the device the user selected is in fact a data modem, and not some other TAPI device. 

(1410) TAPI error: Could not open line device

Before placing a call, AlphaPage checks to be sure that the line is available (and shows error 1105 if it is not), but if there is some problem opening the line (even if TAPI claimed the line was available) this is the error message.

(1415) TAPI error: Could not specify status messages to monitor

After opening a line device, AlphaPage informs TAPI which status messages are important for the call. If there is a problem doing this, this error appears.

(1425) TAPI error: Could not specify port settings prior to opening port

Before placing a call, AlphaPage attempts to set the baud rate, data bits, stop bits, flow control, error correction and data compression settings specified for the modem and messaging service in use. If there is a problem doing this, this error appears.

· Verify with your modem manufacturer that your modem supports the baud rate and data settings required by your messaging service (usually 300, 100, or 2400 baud with 7 Data Bits, Even parity, 1 Stop Bit).

(1435) TAPI error: Could not create call parameters

This error appears if the data structure containing parameters for TAPI cannot be created. This would only happen if the computer ran out of memory.

(1440) TAPI error: Call to lineMakeCall() failed

AlphaPage uses the lineMakeCall() function of TAPI, which opens the serial port. This error appears when this call fails.

(1450) TAPI error: No response to lineMakeCall()

After placing a phone call with TAPI, AlphaPage expects to get some responses back from TAPI, including an announcement that the modems have either connected or disconnected. If those responses don’t arrive within 60 seconds, this error appears.

(1455) TAPI error: Couldn't get port handle from TAPI

After placing the phone call, AlphaPage asks TAPI for direct access to the COM port, through which it can send and receive data. If the port handle is unavailable for some reason, this error appears.

(1460) TAPI error: Could not change call parameters

After dialing a call in Override mode (Modem Configuration), AlphaPage attempts to switch back to standard TAPI mode to actually send pages, then hang up. If the switch back to standard TAPI mode does not work, this error appears.

(1499) TAPI error: Unexpected TAPI error

This is error message used in cases where AlphaPage is able to detect that something has gone wrong with TAPI, but the error is not one of the above listed errors.

TAP Errors

The TAP protocol includes provision for a messaging terminal to report 3-digit error codes back to the AlphaPage software that is trying to send a page. The last three digits of a TAP error are always the same as the digits reported by the paging system. For example, if the TAP terminal returns error code 501, AlphaPage products would show the user error 2501.

(2112) TAP error: Maximum pages entered for session

Some Services limit the number of messages that can be sent in a single session. Check with your Messaging Service for their limit. Exceeding the maximum number allowed per session will result in this message. This message might result when sending to large groups, multiple groups, or a large ad hoc group.

(2113) TAP error: Maximum time reached for session

Some Services limit the session connection time when sending messages. Sending to large groups, multiple groups, or a large ad hoc group may result in this error. Check with your Messaging Service for their limit.

(2212) TAP error: Long message truncated and sent

Some services will automatically truncate and send a long message at the Services Maximum Message Length allowed by the system. Check with your Service for their Maximum Message Length. Make the change to the Messaging Service setup and turn On AutoSplit to avoid this error.

(2214) TAP error: Long message truncated and sent

Paging terminal sent the first X characters of the message, where X is the maximum characters per page allowed. These two errors (2212 & 2214) differ only in that the terminal sends a message along with 2214 that indicates what X is. Since this information is not currently parsed or used in any way by AlphaPage products, both errors show the same message text. Check with your Service for their Maximum Message Length. Make the change to the Messaging Service setup and turn On AutoSplit to avoid this error.

(2501) TAP error: A time out occurred while waiting for input

During Message sending if the Service does not see a response within a specified period this error results. Usually this is caused by a poor connection. Retry sending the message.

(2502) TAP error: Unexpected characters received before start of transaction

Terminal did not get either the <STX>(message block) or <EOT><CR> expected after the client software logged in OK. Could indicate line noise or a timing problem.

(2503) TAP error: Excessive attempts to send/re-send transaction

When the terminal finds that a page contains checksum errors (theoretically the result of line noise), the client software may try to send the message again. If this happens too much, the terminal can end the session with this error message.

(2504) TAP error: Message characters not allowed for this receiver

The page as the terminal received it contained message characters, and the terminal does not recognize that the PIN belongs to a pager with message receiving capabilities. The pager could be a simple beeper or “tone only” device. Note differences between this message and 2505.

(2505) TAP error: Message text not allowed for this receiver

The page as the terminal received it contained alphabetic characters, and the terminal does not recognize that the PIN belongs to a pager with alphabetic message capabilities. The pager could be a standard numeric or “digital” pager. Note differences between this message and 2504.

(2506) TAP error: Excessive invalid pages received

Sending multiple messages that contain invalid Receiver ID's could result in this message. Check the programming of Receivers, or check if the Service has other Dial-up Modem ports for sending messages and for which Dial-up Modem port to use with your specific Receivers.

(2507) TAP error: Login failed, bad login sequence

If this message is received it could be a bad connection – try re-sending the message. Continued errors - check your Data Settings in the Message Service setup (typically should be 7 data, Even Parity, 1 Stop).

(2508) TAP error: Login failed, service not supported

The “service” in this error message refers to the service type specified just before the password in the standard TAP login sequence. The only services currently supported are “PG1(password)” (for automatic page entry) and “M” (for manual message entry), but AlphaPage products only send the “PG1” sequence.

The TAP standard does mention that other services may be added to the TAP protocol, so there is the possibility that there could be a TAP terminal that did not support paging, that is, the “PG1” service type. This is the error that would result from using AlphaPage products to send a page to such a terminal.

(2509) TAP error: Login failed, bad password

Incorrect password. Typically Services do not require a password and the password field in the Service setup should be blank.

(2510) TAP error: Illegal receiver ID

TAP system was expecting the receiver PIN to have a different number of digits, to not contain characters that it did contain, or otherwise be very different. The PIN as received is so screwed up, it can’t even be looked for in a database of PIN numbers.

(2511) TAP error: Unrecognized receiver ID

TAP system does not have a record of any receiver with the PIN number sent. Very common problem with pagers, since the pager’s telephone number and alphanumeric PIN number are sometimes different, and the people selling the pagers sometimes don’t know that.

(2512) TAP error: Temporarily unable to deliver messages to this receiver

Possibly used on two-way systems that know the target pager is not in the service area.

(2513) TAP error: Message exceeds maximum length, rejected

Paging terminal has refused to send a message because it contained more than X characters, where X is the maximum characters per page allowed. 

Check with your Messaging Service for their Maximum Message Length and change the settings in the Messaging Service setup and turn on AutoSplit to avoid this error.

(2517) TAP error: Message exceeds maximum length, rejected

Paging terminal has refused to send a message because it contained more than X characters, where X is the maximum characters per page allowed. 

Check with your Messaging Service for their Maximum Message Length and change the settings in the Messaging Service setup and turn on AutoSplit to avoid this error.

(2514) TAP error: Bad checksum

This error is usually caused by a poor connection / noisy line. Retry sending the message.

(2515) TAP error: Message format error

May be caused by a poor connection / noisy line. Retry sending the message.

(2516) TAP error: Message quota temporarily exceeded

Some receivers may be limited to the number of messages per day or per month, or attempting to send too many messages in a short time period to a specific receiver that might exceed the receiver's capability. If this limit is exceeded this error may result. Check with your Messaging Service about any limits or restrictions on the specific pager.

Network Errors

Network errors indicate a failure in the process of connecting to the internet, finding the paging server on the internet, or actually sending the page to the paging server.

(6001) Network error: Could not connect to internet

Winsock services could not be started, RAS could not be started, or a RAS connection could not be established.

(6002) Network error: Could not connect to host

Most likely caused by problems with the host name or address as entered in the paging service setup or the telnet proxy setup. May also indicate that the host itself is down, or that part of the network connecting the user’s computer to the host is down, or that the host is simply not accepting connections on the specified port.

(6101) Network error: Socket I/O operation failed

Some unexpected error occurred while sending or receiving data.

(6201) Network error: Host terminated connection

The remote host (the SNPP server, or possibly the telnet proxy server, if one is configured) disconnected without warning.

(6202) Network error: Timed out waiting for server

The timeout for the paging service (set up in the paging service properties screen) elapsed with no response from the SNPP server. This problem can sometimes be rectified by increasing the timeout, but it may indicate something wrong with the SNPP server or with the network connection.

(6203) Network error: Host returned error code

SNPP server responded to an SNPP protocol command with a failure code. When this error happens, the explanation text sent by the SNPP server will be included on the error screen along with this error message. That explanation should provide more detail on why the transaction failed. The explanation might be, for example, “550 Error, pager ID must be 10 digits” or “550 Error, pager ID cannot be identified” and so on.

(6301) Network error: Target address or URL appears to be invalid

The URL address for the Messaging Service could not be parsed in order to attempt a connection. Check the Messaging Service address.

WCTP Client-side Errors

(7000) WCTP Error: Could not read WCTP response

Message to a WCTP gateway was able to POST, but the WCTP gateway response was unreadable. Attempt to re-send.

(7001) WCTP Error: WCTP response was garbled, invalid, or unrecognized

The WCTP gateway reply to a message was OK, but the text of the reply cannot be read or is unrecognized. This can happen when a valid web page URL is entered in the Messaging Service WCTP address instead of a valid WCTP gateway address. (Any web server will send a reply back to an HTTP POST operation, but the reply will be HTML and not XML. XML is the expected format of a reply from a WCTP gateway.)

(7002) WCTP Error: Could not POST WCTP message to gateway

Could not connect to the WCTP gateway. Most likely an invalid address was entered in the Messaging Service WCTP address.

(7003) WCTP Error: Bad HTTP status code (check server address?)

The HTTP session returned an error code, or no response from the HTTP session was received. This can happen when a valid web page URL is entered in the Messaging Service WCTP address instead of a valid WCTP gateway address. The internet log (inetlog.txt) may contain the specific HTTP error for further clues.

(7004) WCTP Error: HTTP 407 Proxy Authentication Required

The HTTP session returned a Proxy Authentication error. This can happen when the Internet Connection uses a Proxy Server and you have not turned on Proxy Authentication in the program Internet Setup options. Turn on Proxy Authentication in the Setup Menu . Internet Settings. Enter your Username and Password.

(7005) WCTP Error: HTTP 407 Proxy Authentication – bad username/password

The HTTP session returned a Proxy Authentication error. This can happen when your Proxy Authentication setup contains an incorrect Username or Password. Edit the Proxy Authentication Username and Password in the Setup Menu . Internet Settings. Check with your Network Administrator for the correct Username and Password for Proxy Authentication.

WCTP Server-side Errors

These errors are of the format “7xxx” where “xxx” is the WCTP error code. These are errors returned by the WCTP gateway. The text of the error message indicates the problem.

 XE "Errors:Other" Other Errors

Modem is Not Dialing

General Notes on Dialing Problems: XE "Dialing Problems" 

 XE "Problems: Dialing" 
· Check to see if any other application is using the modem.

· Make sure that the phone line is plugged into the “Line” jack of the modem, and not the “Phone” jack.

· To rule out software conflicts, turn off any fax receive software, communications software, or remote control software before trying to send a message.

· Verify your modem selection

· Check for possible device conflicts.

After dialing a voice or a ring and a beep is heard

· Verify the phone number you entered in your Messaging Service setup. You should always hear a modem connection tone when dialing the correct number.

· Hearing a “ring and a beep” means you have inadvertently programmed a receiver number into your messaging service access phone number.

 XE "Tone Only Error" “Tone Only” or a blank message, only numbers are sent, or message is garbled or incomplete.

If the message  to a wireless receiver is incomplete or garbled, check for the following possible problems:

· Check for a “Message Sent” status in AlphaPage First Responder. This indicates that the wireless receiver message was successfully sent to the wireless messaging service. The wireless messaging service then radio-transmits that message to the wireless receiver(s).

· Check for a low battery in the wireless receiver.

· The wireless receiver could be out of range or in a fringe coverage area for transmission.

· The wireless receiver could be in a building with strong RMI (Radio Magnetic Interference i.e., near many computers).

· The wireless receiver could be in a building or area of a building that is difficult to penetrate with radio transmissions.

· Weak or inoperative wireless receiver (i.e. bad wireless receiver).

· Pagers: Try using the PIN number instead of the pager phone number.

· Verify that the wireless receiver has been programmed at the wireless messaging service as an alphanumeric (text) pager or PCS short messaging receiver. If the wireless receiver is receiving numeric characters in the message but not the letter characters – the wireless receiver has been programmed as a numeric-only wireless receiver in the wireless messaging service system and needs to be programmed for alphanumeric/text.

Addendum T

About Message Templates

Message templates allow you to create custom message entry screens.  This can be useful if you send many messages that contain identical or very similar information.  Much (or all) of the message text can be defined in advance, which can save time and reduce mistakes.  Here’s an example of a message template that might be useful for a singing telegram service:
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The text message includes all of the editable and non-editable text on this screen.  In this case, the message would be:

Singing telegram scheduled for 04/04/2005 14:00 Recipient: Sally Sender: Tom Song: Happy Birthday Address: 123 Main Street, Anytown Notes: Sally’s 40th Message sent at 04/04/2005 12:00

Message templates are created from simple text files that may be created or edited with Windows Notepad.  We’ll call these files template definition files.  Template definition files are saved with a .TML filename extension in the program directory.

Creating Message Templates

To illustrate how message entry templates are written, we’ll first look at a very simple example:
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The template definition file for this custom message entry screen is:

title text "Say Hello"

static text "Hello from "

edit required length 30

This file was saved with the filename “hello.tml” in the program directory.  To use it, a user chooses message recipients, then picks “Template Message…” from the Options menu.  A list of message templates appears, and the user double-clicks on “hello.tml” to see this screen.

The first thing to notice about this template definition file is that each item in the message entry screen occupies a separate line in the template definition file.  The screen title occupies exactly one line, the block of static text occupies exactly one line, and the text edit field occupies exactly one line.  Template definition files must always be written this way.

On each line, the first word indicates what sort of item the line is defining.  We’ll call this an item type.  In this simple definition file, there are just three item types: title, static, and edit.  There are a few other item types available, but we’ll start with these basics.

Each line contains some words after the item type.  We’ll call these additional pieces of information item properties.  Item properties specify additional information about how each item type is handled.  For example, the last line includes the word “required.”  This is an item property that means the edit field must be filled in before the message may be sent.  There are a few other item properties specified here.  Some item properties are just a single word, like “required,” and others are groups of words, like “length 30”.

If we were to break this template definition file down into item types and item properties, we’d get something like this:

Item Type
Item Property
Item Property

title
text “Say Hello”


static
text “Hello from ”


edit
required
length 30



In this example, only the last line has more than one item property. The first two lines have the text property, which is always followed by a string of characters in quotes.  Some item types (like title and static) will be permanently set to the supplied string of characters.  The edit item type also is set to the string of characters, but can be changed by the user. It's not possible to apply every item property to every item type.  Each item type has a few properties that make sense for it.  If a template definition file attempts to apply a property to an item type that can't use that property, the program will display an error message.  Here are the allowed item properties for the item types in our simple example:

Item Type
Properties Allowed

title
text

static
text

edit
text, required, length, nochange

More complete information is included in the Message Template Reference section.

We can see that the title and static item types are very simple, but the edit item type has a few more settings we can try.  Suppose your name is George, and you want your Hello message template to always start with your name already typed-in.  You could change the message template to read:

title text "Say Hello"

static text "Hello from "

edit required length 30 text "George"

Now when you use the message template, it will look like this, without any typing:
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Now you can say hello without typing, but a friend using your PC can also use the template, if they change the name.

Perhaps you've decided that since your name is so short, you may as well save a little room on the screen and trim the name length.  You might change the message template to read:

title text "Say Hello"

static text "Hello from "

edit required length 10 text "George"

With the shorter edit length, the screen will look like this:
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Maybe your friend Tom has been using your computer to say hello so often that he's become a real pest, and you want to prevent him from doing that any more.  You might change the message template to read:

title text "Say Hello"

static text "Hello from "

edit required length 10 nochange text "George"

With the nochange property, the screen will look like this:
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The nochange property turns the editable field gray and prevents it from being changed.  It's functionally equivalent to the static item type.  This is a somewhat silly example - Tom would probably stop saying hello from your computer if you asked him to - but the nochange property may be useful if you make many similar template files, but want to make some editable fields non-editable in some of them.

Message Template Reference

Item Type Summary

Type
Included In Message?
Properties
About

newline
no
(none)
Makes a line break in the message entry screen (but not in the message)

title
no
text
Sets the title of the message entry screen

static
yes
text
Adds non-editable text to the message entry screen

time
yes
auto

nochange
Adds a time control to the message entry screen.

date
yes
nochange
Adds a date control to the message entry screen.

datetime
yes
auto

nochange
Adds a date and time control to the message entry screen.

hours
yes
auto

nochange
Adds an hours control to the message entry screen.

minutes
yes
auto

nochange
Adds a minutes control to the message entry screen.

edit
yes
required

text

length

nochange
Adds an editable field to the message entry screen.

editml
yes
required

text

length

height

width

nochange
Adds a multi-line editable field to the message entry screen.

Item Type Details

newline

newline

Adds a line break to the message entry screen without affecting the message text. Prevents the message entry screen from getting too wide for the screen or for reading comfort.  For example, this template definition is pretty wide; if it got much wider, the message entry box wouldn't fit on some screens:

static text "One item: "

datetime auto

static text "Two items: "

edit length 20 

Here's how it looks:
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With the addition of a newline, the readability and expandability improve:

static text "One item: "

datetime auto

newline

static text "Two items: "

edit length 20 

Here's how it looks:
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title

title text "The Name Of The Game"


[image: image64.png]The Name Of The Game




Sets the title displayed on the message entry screen.  Does not affect the message text.

Property
Effect

text "Your Text Here"
Sets the screen title to Your Text Here

static

static "The rain in Spain"
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Includes non-editable text in the message entry screen. 

Property
Effect

text "Your Text Here"
Includes Your Text Here in message

time

time auto
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Includes a time control in the message entry screen.  The time is shown in 24-hour format ("military time").  The time displayed initially is "00:00" unless the auto property is used.  A user may change the time displayed with the up/down buttons, by typing numbers, or by using the up/down cursor keys.

Property
Effect

auto
Initially shows the current time.

nochange
The time shown cannot be changed.

date

date auto
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Includes a date control in the message entry screen.  The date format is month/day/year.  The current date is always displayed initially.  Clicking the down arrow displays a calendar that can be used to select dates.  The keyboard and up/down cursor keys can also be used to change the date shown.

Property
Effect

nochange
The date shown cannot be changed.

datetime

datetime auto
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Includes a date-and-time control in the message entry screen.  The date format is month/day/year.  The current date is always displayed initially.  The time is shown in 24-hour format ("military time").  The time displayed initially is "00:00" unless the auto property is used. Clicking the down arrow displays a calendar that can be used to select dates.  The keyboard and up/down cursor keys can also be used to change the time and date shown.

Property
Effect

auto
The time control initially shows the current time (the date is always initially the current date).

nochange
The date and time shown cannot be changed.

hours

hours auto
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Includes an hours control in the message entry screen.  The field is limited to the range 00 to 23.  "00" is initially displayed unless the auto property is used.  The hours shown can be changed with the up/down buttons, the up/down cursor keys, or by typing digits on the keyboard.

Property
Effect

auto
Initially shows the hours of the current time (i.e., at 11 at 11:45, 4 at 4:03 etc.)

nochange
The hours shown cannot be changed

minutes

minutes auto
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Includes a minutes control in the message entry screen.  The field is limited to the range 00 to 59.  "00" is initially displayed unless the auto property is used.  The minutes shown can be changed with the up/down buttons, the up/down cursor keys, or by typing digits on the keyboard.

Property
Effect

auto
Initially shows the minutes of the current time (i.e., at 45 at 11:45, 03 at 4:03 etc.)

nochange
The minutes cannot be changed.

edit

edit length 30 text "The rain in Spain"
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Includes an edit field in the message entry screen.

Property
Effect

required
Text must be entered in this field before message may be sent

text "Your Text Here"
Edit field initially contains Your Text Here

length n
Limits text entry to n characters maximum

required
Requires some text to be entered in this field before the message may be sent.

nochange
The text in this edit field cannot be changed.  Makes this edit field behave like a static item.

editml

editml length 90 height 3 width 30 text "The rain in Spain"
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Includes a multi-line edit field in the message entry screen.  Useful for allowing very long text entries.  The format of the message in the multi-line edit control does not affect the format of the message text. 

Property
Effect

required
Text must be entered in this field before message may be sent

text "Your Text Here"
Edit field initially contains Your Text Here

length n
Limits text entry to n characters

required
Requires some text to be entered in this field before the message may be sent.

nochange
The text in this edit field cannot be changed.  Makes this edit field work like a static item.

height
Specifies how many lines high the edit field is.

width
Limits how many characters may be entered on each line.

Other InfoRad Products

InfoRad Online Catalog

Click here to view the InfoRad Online Catalog \Relate "InfoRad Online Catalog" \D2HHelpMacro ||WinHlp40||ExecFile(`ap_info.hlp',`',1,`') /Button .

 XE "Warranty" 

 XE "License Agreement" \r "D2HBLicense_Agre67" Warranty and License Agreement

AlphaPage® First Responder Warranty

AlphaPage® First Responder

InfoRad Inc. warrants only that the diskette upon which the software is furnished shall be free from substantial defects in materials and workmanship under proper and normal use for a period of ninety (90) days from the date of delivery.

This warranty does not extend to any diskette which has been damaged as a result of accident or misuse; or as a result of service or modification by anyone other than InfoRadInc. 

InfoRad Inc. does not warrant that the software will meet your requirements or that the operation of the software will be error free. You assume full responsibility for the selection of the software, its installation, use, and results. In no event will InfoRad Inc. be liable to you or any other person for any damages, including any consequential damages, expenses, lost profits, lost data, or other damages arising out the use or of the inability to use the software.

No other warranties, either express or implied, are made with respect to this software, including, but not limited to, the implied warranties of fitness for a particular purpose, and InfoRad Inc. expressly disclaims all warranties not stated herein.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state. Some states do not allow the limitation or exclusion of incidental or consequential damages for consumer products, so the above limitations or exclusions may not apply to you.

InfoRad Inc.
635 East 185th St.
Cleveland, OH 44119
PHONE (216) 531-1313 

www.inforad.com

License Agreement

AlphaPage® First Responder

Read this agreement carefully before using this software. Use of this software by you or your agent, including your employee, means that you accept the terms of this License Agreement. If you do not agree to the terms of this license agreement, discontinue use of this software now. A refund is issued only if you have removed all the associated software files related to this package from your computer system and have destroyed all backup copies before returning the software. Your money will be refunded if you have honored the above stated refund terms and the package is returned within 30 days of purchase. If a demonstration version has been supplied, it in addition to the terms stated in this agreement is not for sale or copy. The demonstration version is supplied solely for demonstrating the product’s features and ability to operate.

This License Agreement licenses the use of this product for the United States of America and in countries that adhere to the copyright laws of the United States of America. No use of this software product is authorized or granted by this agreement beyond the United States of America and  countries that adhere to the copyright laws of the United States of America.

THE LICENSEE IS ENTITLED TO:

1. Use one copy of the licensed program on a single machine unless this software has been purchased with a multi-user SITE or LAN license;

2. Remove the licensed program from one computer and install it on another. At no time is it permitted to make multiple copies for others to use or transfer the program license except under the terms set forth within this agreement; 

3. Make one copy of the software solely for backup purposes;

4. Transfer the program and license to another party so long as the other party agrees to the terms and conditions of this Agreement, and written notification is given to AlphaPage, Inc. of said transfer. If the program is transferred, all copies not transferred, whether in machine readable or printed form must be destroyed. This includes all modifications and portions of the program used;

5. Use the manual for its intended purpose by the licensee or his agents.

6. Telephone Technical Supportxe "Technical Support" for 90 days for Registered users. Registration may be in the form of Auto-Registration,xe "Auto-Registration" mail in registration form, fax in registration form, or telephone registration.

THE LICENSEE IS PROHIBITED FROM:

1. Using, modifying, copying or in any way transferring, by any means or medium the licensed program except as expressly permitted by this Agreement or by prior written agreement of Information Radio Technology Inc.;

2. Distributing, renting, giving, lending, sub-licensing or leasing, disseminating, translating, reverse engineering, decompiling, disassembling and/or creating derivative works from the licensed program;

3. Using or allowing use of the backup copy unless the purchased diskette or file becomes defective;

4. Copying the manual or using the manual except as authorized.

COPYRIGHT: 

The software is licensed to you for your use, the software is not sold to you. The software and documentation is owned by InfoRad, Inc., and  is protected by the copyright laws of the United States and by international treaties. You must reproduce and include the copyright notice on any backup copy. Any copy of the software made by you will be the property of InfoRad, Inc. and is subject to the terms and conditions of this agreement.

This license agreement terminates with the licensed purchaser or user upon transfer of this program or for failure to comply with the terms of this Agreement. Upon termination, the licensee has no rights to use this program and must destroy all copies in his or her possession.

InfoRad, Inc.  retains all rights not expressly granted by this Licensee Agreement. This Agreement constitutes the complete and exclusive Agreement between the parties. InfoRad reserves the right to change the terms of this agreement with subsequent releases of the software.

InfoRad Inc.
635 East 185th St.
Cleveland, OH 44119
PHONE (216) 531-1313 

www.inforad.com
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